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เทคนิคการสรางงานนําเสนออยางมืออาชีพ 
ดวย ProShow Gold 

 

เทคนิคการติดต้ังโปรแกรม ProShow Gold 
โปรแกรม ProShow Gold เปนโปรแกรมสําหรับการเรียงลําดับภาพเพื่อการนําเสนอแบบ

มัลติมีเดียที่มีความสามารถ สรางผลงานไดในระดับมืออาชีพดวยเทคนิคพิเศษมากมาย ใชงานได

งายเหมาะสําหรับการสรางงานนําเสนอสื่อการเรียนการสอน การแนะนําอัตชีวประวัติ สามารถ

เขียนชิ้นงานออกมาในรูปแบบของวิดีโอซีดี 

 
การติดต้ังโปรแกรม 

การติดตั้งโปรแกรมทําไดงายๆ ดวยการดับเบิ้ลคลิกที่ไฟล psgold_25_1635.exe ดังใน

ภาพขางลางนี้ 

 
จะพบกับกรอบหนาตาง ProShow Gold 2.5 Installation ใหคลิกที่ปุม Next 
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การสรางงานนําเสนอดวย ProShow Gold 2 

หนาตางถัดไปจะเปนกรอบแจงเตือนการอัพเกรดฟรีสําหรับผูลงทะเบียนจัดซื้อผลิตภัณฑ 

จากทางบริษัท (ถาไมมีเวอรชั่นเดิมจะเปนการติดตั้งใหมและตองลงทะเบียนใหมดวย) คลกิที ่Next 

ตามระเบียบอันดีงามตอไปไดเลย อยาชา... 

    
หนาตาง License Agreement ยอมรับในลิขสิทธิ์ของเขาแตโดยดี (ถาไมยอมรับก็ติดตั้ง

ไมไดอยูแลว) หนาตางถัดไปคือตําแหนงติดตั้งโปรแกรม คลิก Next ไดเลย 

    
หนาตางถัดมาจะถามวาตองการสรางไอคอนโปรแกรมที่ตําแหนงใดบาง Start Menu, 

Desktop และ Quick Launch เลือกเอาตามชอบ แลว Next ถึงขั้นนี้ก็พรอมที่จะติดตั้งโปรแกรมได

แลวคลิกที่ปุม Install ไดเลย 

     

 

 

ติดตั้งเสร็จแลว ตองทําการรีสตารทเครื่องกอน 

นะครับ เพื่อใหมีการตั้คาในรีจิสตร้ีของระบบ 

ข้ันตอนตอไปจะเปนการลงทะเบียนเพื่อใหใชงาน

ระบบไดตลอดไป 

งานเทคโนโลยีสารสนเทศ  โรงเรียนเบ็ญจะมะมหาราช 
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การสรางงานนําเสนอดวย ProShow Gold 3 

การลงทะเบียนใหดับเบิ้ลคลิกไฟลชื่อ tmg-psg25.exe ในโฟลเดอร ProShowGold\ 

keygen จะปรากฏหนาตางการลงทะเบียนดังภาพลาง (กรอบขวามือ) 

   
ใหใสชื่อของคุณ หมายเลขโทรศัพท (อยาใสมั่วแบบ 0123456789 นะครับใชไมได) แลว

คลิกที่ปุม Generate จะไดหมายเลข Unlock password เพื่อนําไปลงทะเบียนตอไป 

    
 

เปดโปรแกรม ProShow Gold ไปที่เมนู Help คลิก

ที่ Enter Registration Key(s) จะเปดกรอบสําหรับ

ลงทะเบียนขึ้นมาใหกรอกชื่อ หมายเลขโทรศัพท 

และหมายเลขลงทะเบียนลงไป ถาถูกตองจะพบ

กับขอความแสดงความยินดีดังดานซายมือ 

 
 

เปนอันเสร็จส้ินสมบูรณสําหรับการติดตั้งโปรแกรม ProShow Gold ใหสามารถใชงานได

ครบถวนทุกคุณสมบัติแลว เหลือเพียงศึกษาเทคนิคตางๆ เทานั้น 

งานเทคโนโลยีสารสนเทศ  โรงเรียนเบ็ญจะมะมหาราช 
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การสรางงานนําเสนอดวย ProShow Gold 4 

เทคนิคการติดต้ัง Absolute Sound Recoder 

โปรแกรมสําหรับการบันทึกเสียงในเครื่องคอมพิวเตอรมากมาย ซึ่งมีความสามารถที่

แตกตางกันออกไป สําหรับการสรางงานนําเสนอนี้ผูเขียนพบวามีโปรแกรมเล็กๆ ที่ใชงานงาย 

คุณภาพ และรูปแบบการบันทึกเสียงมีมากมาย ครบถวนตามที่ตองการ คือโปรแกรม Absolute 

Sound Recorder ซึ่งวิธีการติดตั้งก็ไมมีอะไรยุงยาก สามารถคลิก Next and Next ไดเลย 

   
เพียงดับเบิ้ลคลิกที่ไฟลติดตั้ง ชื่อ absrecorder.exe ขนาด 2.3 MB ก็จะปรากฏหนาจอ

ชวยเหลือการติดตั้งดังภาพบน 

 

   
เหมือนกับโปรแกรมทั่วๆ ไปคือตองยอมรับลิขสิทธิ์ของโปรแกรมเขากอนเลือกในวงกลม

แดง แลวก็ Next จะปรากฏหนาตางแสดงโฟลเดอรติดตั้ง คลิก Next ไดเลย 

งานเทคโนโลยีสารสนเทศ  โรงเรียนเบ็ญจะมะมหาราช 
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การสรางงานนําเสนอดวย ProShow Gold 5 

   
โปรแกรมจะถามใหตั้งชื่อเมนูโฟลเดอร และการสรางปุมไอคอนโปรแกรมบนหนาจอ ก็ให

คลิก Next ผานไปไดเลย 

   
โปรแกรมจะแสดงรายละเอียดวาพรอมจะติดตั้งแลว คลิกที่ปุม Install รอจนเสร็จ 

   
เมื่อโปรแกรมติดตั้งเสร็จคลิกที่ปุม Finish จะปรากฏหนาตางโปรแกรมดังภาพขวามือ ให

ลงทะเบียนโปรแกรมดวยการคลิกที่เมนู Help > Register กรอกชื่อผูใชงานและเลขทะเบียนจาก

ไฟล Readme.txt ก็เปนอันเสร็จส้ิน ใชงานไดเลย 

งานเทคโนโลยีสารสนเทศ  โรงเรียนเบ็ญจะมะมหาราช 
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การสรางงานนําเสนอดวย ProShow Gold 6 

เทคนิคการติดต้ัง Nero SoundTrax 
โปรแกรม Nero SoundTrax เปนชุดโปรแกรมที่มาพรอมแลวในโปรแกรมสําหรับการเขียน

ซีดีชื่อดังคือ NeroBurningRom ตั้งแตเวอรชั่น 5.0 เปนตนมา จึงไมขอแสดงรายละเอียดใน 

การติดตั้งโปรแกรม 
 

 
 

เมื่อเรามีโปรแกรมสําหรับการทํางานครบถวนแลว ตอไปก็จะเปนขั้นตอนในการเตรียม

ความพรอมสําหรับการนําเสนอ ซึ่งมีรายละเอียดปลีกยอยเชิงเทคนิคคอนขางมากทีเดียว เพื่อให

การนําเสนอผลงานของเรามีความสมบูรณ นาสนใจ ดังนี้ 

1. การเตรียมวัตถุดิบ หมายถึง การเตรียมขอมูลเร่ืองราวที่จะนําเสนอในเชิงลึกทั้ง

ประวัติความเปนมา  ส่ิงที่นายกยองเปนเกียรติยศ รางวัล/การยกยองชมเชยที่ เคยได รับ 

สภาวการณปจจุบัน ความมุงหวังหรือทิศทางในอนาคต เชน การนําเสนอที่เกี่ยวกับหนวยงานก็

จะตองเสาะหาประวัติของการกอตั้ง ความเปนมา ชื่อเสียง/เกียรติยศ ผลงานในปจจุบัน และ

ทิศทางพัฒนาในอนาคต 

2. การเตรียมภาพ ส่ือประกอบ ที่เกี่ยวของกับเร่ืองราว ใหไดมากที่สุด ในมุมมองที่

แตกตางกันออกไป ปรับแตงความคมชัด สีสัน ขนาดของภาพใหเหมาะสม ภาพถายที่เปนแนวตั้ง

อาจจะตองมีการปรับแตงใหมใหอยูในแนวนอน ดวยโปรแกรมตกแตงภาพอยาง PhotoShop 

งานเทคโนโลยีสารสนเทศ  โรงเรียนเบ็ญจะมะมหาราช 
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การสรางงานนําเสนอดวย ProShow Gold 7 

3. การเขียนบท (Script) นับวาเปนหัวใจสําคัญของการนําเสนอเรื่องราวที่ดี ไมวาจะ

เปนการนําเสนอเรื่องราวผานสื่อนําเสอ การผลิตรายการโทรทัศน วิทยุ หรือแมแตการแสดงบนเวที 

เพราะบทจะเปนตัวกําหนดรายละเอียดของงาน เชน เสียงประกอบ เสียงบรรยาย ภาพที่นําเสนอ 

ลักษณะการเคลื่อนที่ของภาพ (กลอง) มุมมอง (มุมกลอง) และตําแหนงของตัวละคร ซึ่งการเขียน

บทสําหรับการนําเสนอผานสื่อแตละแบบจะแตกตางกันเล็กนอยในรายละเอียด ในที่นี้จะเนน

เฉพาะการนําเสนอผานภาพนิ่งดวยโปรแกรม ProShow เทานั้น 

เรามาดูกันกอนวาเรามีคุณสมบัติของนักเขียนบทที่ดีแลวหรือยัง? ลองสํารวจตัวเองดู 

1. ตองเปนคนชางคิด ชางฝน สามารถจินตนาการเรื่องราวไดตอเนื่องและเขียนเปนคํา

บรรยายพรรณนาออกมาได 

2. ตองเปนคนอยากรูอยากเห็น (แตไมใชสอดแนม) มีความขยันหมั่นบันทึก การรูและ

เห็นมากยอมมีขอไดเปรียบในการจินตนาการ และการจดบันทึกอยางสม่ําเสมอจะทําใหเรามี

ขอมูลสําหรับการเลือกและตัดสินใจมาก 

3. ตองรูจักใชภาษา  คือใชภาษางายๆ ส้ัน  กระชับ ตรงประเด็น  เปนภาษาที่ ส่ือ

ความหมายไดทันที พูดงายๆ คือไมตองมาแปลภาษาไทยเปนไทยอีก คําบรรยายจะตองเขาใจงาย

ไมใชศัพทสูง คําพูดตองไมแนนจนเกินไป (จะกลายเปนรายการขาวไป) คําบรรยายจะตองชวยให

เกิดการโนมนาวผูชมคลอยตามไปกับภาพที่เรากําลังนําเสนอ 

4. ตองเขาใจจุดมุงหมายของการนําเสนอในเรื่องนั้นๆ บทจะตองตีกรอบใหผูฟงคลอย

ตามอยางเปนขั้นตอน พยายามใหภาพเปนตัวชวยเลาเรื่องโดยไมตองใชคําพูดมากมาย เพราะ

ภาษิตจีนบอกวา ภาพเพียงภาพเดียวอาจแทนที่คําพูดไดมากกวา 1,000 คํา 

5. ตองมีความเพียร มีวินัยและทํางานเปนทีมได ความเพียรคือการพยายามเขียนๆๆๆ 

และปรับแกไขใหสมบูรณ การมีวินัยคือตองบังคับตนเองใหงานจบทันเวลา และแนนอนเราตอง

ทํางานกับคนอ่ืนๆ เพื่อใหงานลุลวงจึงตองมีความไววางใจกัน 

ลําดับขั้นตอนการเขียนบทนําเสนอ (Presentation Script) 

1. การเขียนโครงเรื่องและการดําเนินเรื่อง (Plot or Treatment) เปนการเรียบเรียง

เร่ืองราวอยางยอใหครอบคลุมประเด็นหลักทั้งหมด ทิศทางการดําเนินเรื่องเปนไปในลักษณะใด 

สภาพบรรยากาศในเรื่องตั้งแตเร่ิมตนจนถึงบทสรุปสุดทายเปนอยางไร รวมทั้งรูปแบบการนําเสนอ

จะใชรูปแบบใด (เลาจากจุดเริ่มตนจนถึงจุดสุดทาย หรือจะนําความสําเร็จมาเลากอนยอนสูอดีต

และทิศทางในอนาคต) รูปแบบการเขียนไมไดมีการกําหนดรูปแบบไวตายตัว สวนใหญจะเขียนใน

ทํานองการเลาเรื่องวามีอะไรเกิดขึ้นบาง เปนโครงเรื่องยอ ในบางเรื่องที่มีความซับซอนมากอาจจะ

งานเทคโนโลยีสารสนเทศ  โรงเรียนเบ็ญจะมะมหาราช 
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การสรางงานนําเสนอดวย ProShow Gold 8 

มีการแจกแจงรายละเอียดออกไป ถาในทางการเขียนบทภาพยนตรจะเรียกวา สกรีนเพลย 

(Screenplay) 

การเขียนเรื่องยาวหรือสกรีนเพลยนี้ เปนการเขียนอยางพรรณนาใหหลับตามองเห็นภาพ 

ทั้งนี้การเขียนยิ่งละเอียดยิ่งดี อาจจะกลาวถึงคําพูดและเสียงประกอบในแตละชวงตอนไวดวย 

เพราะจะทําใหการเขียนบทงายขึ้น 

2. การเขียนบัตรเรื่อง (Story Board Cards) เปนการนําเอาเรื่องยอมาตีเปนภาพ และ

คําบรรยายตั้งแตเร่ิมตนจนบทสุดทาย โดยใชกระดาษแข็งขนาด 4*6 นิ้ว ในกรอบสี่เหลี่ยมสําหรับ 

การวาดภาพประกอบ อาจเปนภาพโครงราง 

หรือภาพการตูนลายเสนแสดงรายละเอียดของ

เร่ือง เพื่อใหชางภาพถายภาพไดตรงใจคน

เขียนบท มุมขวาจะเปนหมายเลขลําดับบัตร 

ถัดมาจะเปนรายละเอียดของภาพ (มุมกลอง) 

และเทคนิคตางๆ  สวนลางสุดจะเปนคํ า

บรรยายและเสียงประกอบ 

บัตรเรื่องนี้แมเราจะเรียงลําดับไวแลว ก็ยังสามารถจัดเรียงสลับไดเพื่อใหเนื้อหามีความ

ถูกตองสมบูรณล่ืนไหลไมสะดุด 

3. การเขียนบท (Script Writing) เปนการนําเอาเนื้อหาที่ผานการจัดเรียงอยางถูกตอง

แลวจากบัตรเรื่องมาเขียนลงในตารางเพื่อสรางความตอเนื่องและสะดวกในการทํางาน ทั้งการจัด

เรียงลําดับภาพ การบันทึกเสียงบรรยายและเสียงประกอบตางๆ  
บทเรื่อง ............................................................................................................................... หนาที่ .......... 

หนวยงาน ......................................................................................................... ความยาว .................นาที 

ผูเขียนบท ............................................................. ผูบรรยาย .................................................................... 

ลํา
ดับ
ที่ 

ภาพ/การเคล่ือนที่ เทคนิค 

เว
ลา

(s
) 

คําบรรยายและเสียงประกอบ 

1     

 
2     

 
3     

 

 ลําดับที่....... 

 ภาพ .......... 

 .................. 

 เทคนิค ....... 

 .................. 

คําบรรยาย/เสียง .............................................................. 

........................................................................................ 

....................................................................................... 
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การสรางงานนําเสนอดวย ProShow Gold 9 

ในแบบฟอรมการเขียนบทจะมีชองเพิ่มเติมรายละเอียดในขั้นตอนการผลิตคือ 

เทคนิค หมายถึง เทคนิคการปรับเปลี่ยนผสมภาพในแตละเฟรมใชเทคนิคใด เชน การตัดชนกัน 

(Cut in) การกวาดภาพรูปแบบตางๆ (Wipe) การเลือนภาพเขาออก (Fade 

in, Fade out) และการเลือนภาพเขาหากัน (Dissolve) 

เวลา หมายถึง ระยะเวลาของภาพที่ปรากฏในชวงนี้มีหนวยเปนวินาที ใชเพื่อการควบคุม

ความยาวของเรื่องใหกระชับ ตรงตามเวลาที่กําหนด 

การเขียนบทโทรทัศนที่ดีนั้น คงไมสามารถบอกถึงรายละเอียดใหเปนตัวหนังสือได การ

ฝกฝนในการเขียนอยางสม่ําเสมอและดูตัวอยางจากรายการสารคดี การนําเสนอตางๆ ที่ดีๆ แลว

นํามาประยุกตใชใหเหมาะสมกับงานของเราจะเปนการดีที่สุด เมื่อเขียนบทเสร็จแลวควรอาน

ทบทวนอีกครั้งพรอมจับเวลา ถายังไมพอใจในจุดนั้นอีก เคล็ดลับที่ดีอยางหนึ่งคือ การอาน

ดังๆ จะเห็นความไมเหมาะสมของบทไดอยางชัดเจน หรือใหคนอื่นๆ ชวยอานดูจะพบขอบกพรอง

ไดงาย 
หลักสําคัญในการเขียนบทที่ดี 

1. บทที่ดีจะตองมีแกนของเรื่อง (Theme) เปนจุดสําคัญที่สุดของเนื้อหา เพื่อไมให

เนื้อหาเบี่ยงเบนไปจากจุดสําคัญของเรื่องมากเกินไป 

2. บทนําเสนอควรมีการวางโครงเรื่องที่ดี ตั้งแตการนําเรื่องชวนใหติดตาม มีการถวง

เร่ืองและขยายรายละเอียด บททุกเรื่องจะตองมีจุดสุดยอด (Climax) ของเรื่องและการสรุปปดใน

ตอนทาย อัตราสวนของเนื้อหาทั้งหมดที่เหมาะสมคือ บทนําไมควรยาวเกิน 10% เนื้อหา 80% 

และสรุปปดทายอีก 10% 

3. ภาษาของบทนําเสนอควรมีความสละสลวยและลื่นไหลไปตามเนื้อเร่ือง ควรใช
ภาษาพูดมากกวาภาษาเขียน สรางความรูสึกใหเหมือนกับวากําลังคุยกับผูดู คําสั้นกระชับที่เขาใจ

งาย ใหความรูสึกรวมไปกับการแสดงภาพประกอบ 

สรุปอีกครั้ง “การเขียนบทที่ดี ก็คือ เริ่มตนใหต่ืนเตน ดําเนินเรื่องใหราบรื่น และจบ
ทายใหประทับใจ” 
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การสรางงานนําเสนอดวย ProShow Gold 10 

ข้ันตอนการสรางงาน 
ในการทํางานที่เกี่ยวกับระบบไฟลคอมพิวเตอรเพื่อไมใหเกิดความสับสน ควรที่จะสราง

ระบบเก็บงานในโฟลเดอรเปนการเฉพาะ เพื่อใหคนหาและจัดการไฟลไดงาย เชน โฟลเดอรเก็บ

งานและมีโฟลเดอรยอยสําหรับเก็บไฟลภาพ ไฟลเสียงที่เกี่ยวของ 

 
 

การบันทึกเสียงบรรยายและเสียงประกอบ 
หลังจากการเขียนบทนําเสนอและแกไขปรับปรุงจนเปนที่พอใจแลว ลําดับตอไปจะเปน

ข้ันตอนการบันทึกเสียงบรรยายและเสียงประกอบ ซึ่งเราจะใชเครื่องมือพื้นฐานที่หาไดงาย มี

คุณภาพพอสมควร และสะดวกในการใชงาน 

อุปกรณที่ตองใชในการบันทึกเสียงประกอบดวยไมโครโฟน หัวตอแปลงสําหรับแจค

ไมโครโฟนปกติมาเปนขั้วตอเขากับ Mic in ใน Sound Card เครื่องคอมพิวเตอร ซีดีเพลงประกอบ

ที่เหมาะสม หรือไฟลเพลง MP3 และหองที่มีความเงียบพอประมาณ 
การตอพวงอุปกรณ 

ตัวแปลงขนาดแจคไมคใหญ > เล็ก แจคไมคเดิม 
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การสรางงานนําเสนอดวย ProShow Gold 11 

ขั้นตอนการบันทึกเสียงบรรยาย 
การบันทึกเสียงบรรยายดวยโปรแกรม AbsoluteSound Recorder นั้นเราจะเริ่มจากการ

คลิกเลือกโปรแกรมใหทํางานจากไอคอนบนหนาจอหรือจากเมนู Start > Programs > Absolute 

Sound Recorder เพื่อทําการตั้งคาการทํางานของโปรแกรมดังนี้ 
การต้ังคาการบันทึกเสียงที่เมนู Options 

   
 

กอนทําการบันทึกเสียงจะตองมีการปรับแตงกันกอน ดวยการคลิกที่ปุม Options เพื่อเขา

ไปปรับแตงดังนี้ 

1. โฟลเดอรเก็บเสียงที่บันทึกแลว (Save Path) ใหกําหนดไวที่โฟลเดอรงานของเราจาก

ตัวอยางจะเก็บไฟลเสียงไวในโฟลเดอร Sound 

2. กําหนดรูปแบบของไฟลเสียงที่บันทึก ในภาพตัวอยางเลือกเปนชนิด MP3 บันทึกที่

คุณภาพระดับ 44100 Hz, 128 kbps ถาเลือกเปน WAV, WMA ขนาดไฟลจะใหญกวา 

3. กําหนดระยะเวลาการบันทึก ในตัวอยางเลือก No Limit สามารถกําหนดความยาว

ตามตองการไดจากชองตัวเลือกดานลาง 

เมื่อเปนที่พอใจแลวก็คลิกที่ปุม OK เพื่อดําเนินการในขั้นถัดไป 
การต้ังคาในแถบ Recording Controls 
ในแถบตัวเลือกนี้จะเปนการตั้งคาสําหรับแหลงของเสียง (Source) ที่ตองการบันทึก ใน

กรณีของเราคือการเลือกบันทึกจากไมโครโฟน (แตตัวโปรแกรมสามารถจะบันทึกเสียงจากแหลง

อ่ืนๆ ได เชน จากการเลนแผนซีดี จากชองตอ Aux, Line in และอื่นๆ ข้ึนอยูกับซาวการดรุนที่มีอยู

ในเครื่องนั้นสนับสนุนหรือไมดังภาพในหนาถัดไป 
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การสรางงานนําเสนอดวย ProShow Gold 12 

 
จากภาพบน เราเลือกบันทึกจากไมโครโฟน จะมีปุมสไลดเพื่อการปรับความแรงระดับ

สัญญาณที่ไดรับจากไมโครโฟน (แตละยี่หอจะไมเทากัน ตองทดลองบันทึกและเปดฟงเสียงกอน)  

หากระดับความดังที่ไดยังไมเปนไป

ตามที่ตองการใหคลิกที่ปุม  Advanced 

เพื่อเขาไปปรับการ Boot เพิ่มไดดังภาพ 

 

ทั้งนี้ ข้ึนอยูกับคุณภาพซาวดการด

และไมโครโฟนที่นํามาใชดวยใหทดลอง

ดูกอนการบันทึกเสียง 
 

การต้ังคาในแถบ Playback Volume Controls 

 
เฉพาะในแถบนี้ใหกําหนดหยุดการทํางานของไมโครโฟน (Mute) ขณะฟงเสียงที่บันทึก 

เพื่อปองกันการยอนกลับของสัญญาณ (Feedback) จะมีเสียงหวีดหอนเกิดขึ้น 

การต้ังคาในแถบ File Info 

ในแถบนี้จะเปนการแสดงรายละเอียดของไฟลที่เราไดบันทึก สามารถเปลี่ยนชื่อไฟลและ

รายละเอียดตางๆ รวมทั้งการทดลองฟงเสียงที่ไดบันทึกไวแลว ดังภาพในหนาถัดไป 
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การสรางงานนําเสนอดวย ProShow Gold 13 

 
ในขั้นตอนการบันทึกเสียงนั้น เราสามารถจะตรวจสอบคุณภาพของเสียงไดจากหนาตาง

แสดงผลในแถบ Record Sound ซึ่งจะแสดงในรูปของบารกราฟ และสเกลเสียงในภาพดานลาง 

ไมควรใหสเกลสีแดงเต็ม 

 
การบันทึกเสียง เมื่อตอพวงอุปกรณและปรับแตงเสียงทดสอบเปนที่พอใจแลว ก็สามารถ

จะบันทึกไดทันที ดวยการกดปุม Record สีแดง สามารถหยุดชั่วคราว (Pause) และบันทึกตอได 

หรือหยุดการบันทึก (Stop) เมื่อตองการ จะปรากฏชื่อไฟลที่บันทึกแลวในกรอบ File Info ดังภาพ

บน ซึ่งโปรแกรมจะตั้งชื่อใหเปน Untitled1.mp3, Untitled2.mp3, Untitled3.mp3,… ไปเร่ือยๆ ทกุ

คร้ังที่เร่ิมบันทึกเสียงใหม เราสามารถเปลี่ยนชื่อไฟลได 

การบันทึกเสียงบทบรรยาย ควรบันทึกเปนทอนๆ ตามเฟรมในบทที่ไดเขียนไวแลว เพื่อ

ความสะดวกในการผสมเสียง และลดการผิดพลาดในการอานบทยาวๆ ลงได การบรรยายที่ดีควร

จะมีการเนนหนักเบาในชวงตางๆ เหมือนกับการพูดกับผูชมใหเกิดความนาฟง จับใจ 
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การสรางงานนําเสนอดวย ProShow Gold 14 

การผสมเสียงบรรยายและดนตรีประกอบดวย Nero SoundTrax 

 
โปรแกรม Nero SoundTrax เปนโปรแกรมที่มาพรอมกับ NeroBerningRom ใชสําหรับ

การปรับแตงผสมเสียงตางๆ เขาดวยกัน เหมือนกับมีเครื่องผสมเสียง (Mixer) ในหองบันทึกเสียง

มาติดตั้งในคอมพิวเตอรของเรา ดังภาพบนซึ่งมีการใชงานงายๆ ดังนี้ 

1. การเพิ่มเสียงลงไปในแทรคเสียงที่ 1 (ในที่นี้จะนําไฟลเสียงเพลง Background เขามา

กอน 1 เพลง) ดวยการคลิกที่เมนู Inser > Audio File… จะมีกรอบใหเลือกเพลงที่ตองการนําเขา 

 

ปรับเสียงที่นี ่

2. เราสามารถปรับระดับความดังของเสียงและความสมดุลซายขวาได 
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การสรางงานนําเสนอดวย ProShow Gold 15 

3. ถาเสียงแบ็คกราวดยาวไมพอหรือตองการเปลี่ยนบรรยากาศใหเขากับเนื้อหาสามารถ
เพิ่มแทร็คเสียงเขาไปไดอีก โดยคลิกที่เมนู Insert > New Track จะเกิดแทร็ดเสียงใหมใหคลิก

เลือกที่แทร็คนี้และเพิ่มเสียงเขาไป (ตามขั้นตอนที่ 1) 

4. ตอไปเราจะเพิ่มแทร็คเสียงบรรยายเขาไป พรอมทั้งเสียงที่ไดบันทึกไว (ทําตามขั้นตอน

ที่ 3 แตไฟลเสียงบรรยายทั้งหมดจะอยูในแทร็คเดียวกัน) ดังภาพดานลาง 

 
แทรคเสียงที่ 1 แทรคเสียงที่ 2 

เสียงบรรยาย 1 เสียงบรรยาย 2 

5. ข้ันตอไปเราจะทําการปรับระดับของเสียงประกอบใหมีความดังลดลง เมื่อเสียง

บรรยายเริ่มข้ึน และจะเพิ่มความดังเสียงประกอบเมื่อจบคําบรรยายในแตละชวง ดวยการคลิกที่

แทร็คเสียงที่ 1 แลวไปที่เมนู Track > Add Volume Curve จะเกิดแนวเสนตรงเหนือแทร็คนั้น 

 
เสนระดับเสียงแทร็ค 1 เสนระดับเสียงแทร็ค 2 

เสียงบรรยายที่ 1 เสียงบรรยายที่ 2 

6. เราสามารถเพิ่มหรือลดเสียง ณ ตําแหนงใดๆ บนเสนระดับเสียงนี้ดวยการใชเมาส

คลิกที่ตําแหนงบนเสนแลวลดหรือเพิ่มระดับของเสียง จากตัวอยางจะเปนการลดระดับเสียงของ

แทร็คที่ 1 ใหผสานเขากับเสียงในแทร็คที่ 2 ดวย 
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การสรางงานนําเสนอดวย ProShow Gold 16 

7. ใชวิธีการดังตัวอยางขางตนสําหรับการผสมเสียงบรรยายจนครบทุกเฟรม การวาง

ตําแหนงของเสียงบรรยายแตละเฟรมใหมีชองวางเวลาไมเทากันได ดวยการขยีบตําแหนงของเสียง

บนแทร็คไปมา จนไดเวลาในการนําเสนอครบถูกตองตามบทที่กําหนดไว 

8. เมื่อปรับระดับของเสียงและการผสมเสียงบรรยายและเพลงประกอบตางๆ สมบูรณ

จนเปนที่พอใจแลวใหนําไฟลออกไปใชงานดวยการคลิกที่เมนู File > Export to Audio File… ซึ่ง

สามารถสงออกไดหลายสกุลทั้งไฟล WMA, Wave, MP3, MP4, Ogg (แนะนําใหใชนามสกุล 

Wave ไดคุณภาพเสียงที่ดีและใชงานไดดีใน ProShow Gold ตั้งชื่อไฟลแลวบันทึกเก็บไวใน

โฟลเดอร Sound 

9. ในตัวโปรแกรม Nero SoundTrax มีปล๊ักอิน (Plug in) สนับสนุนการปรับแตงเสียง

พิเศษ (Effect) มากมาย เชน เสียงกอง (Reverb) เสียงประสาน (Chorus) ดวยการเลือกแทร็คที่

ตองการเพิ่มเทคนิคพิเศษ ไปที่เมนู Inser > Effect Into > Track Effect Chain…  

   
จากกรอบบนเราจะเลือกที่ Add > Effect > Reverb.. จะไดกรอบหนาตางดานขวามือ 

เพื่อปรับแตงเสียงเพิ่มเติม เมื่อพอใจแลวปดหนาตางนี้ไป เสียงในแทร็คนั้นก็ไดเสียงพิเศษตาม

ตองการ ในแตละเทคนิคพิเศษจะมีคามาตรฐานตั้งไวใน Preset > สามารถเลือกใชงานไดโดยไม

ตองปรับแตงเอง 

หากไมพอใจตองการเอาเทคนิคพิเศษออกก็เพียงแตกลับมาที่หนาตางนี้อีกครัง้ คลกิลงบน

เทคนิคพิเศษ (กรอบสีเขียว แลวลบออก) 

10. หากตองการใหเสียงบรรยายแตละทอนมีเทคนิคพิเศษทางดานเสียงแตกตางกัน 

จะตองแยกเสียงบรรยายทอนนั้นๆ ออกไปอยูในอีกแทร็คหนึ่งแยกตางหาก 
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การเตรียมภาพกอนนําไปใชในโปรแกรม ProShow Gold 
1. ภาพที่จะนํามาใชงานสามารถใชภาพถายที่สแกนเปนไฟลแลว หรือภาพจากกลอง

ดิจิตอล โดยจัดเรียงลําดับดวยการเปลี่ยนชื่อเปนตัวเลข 

2. ปรับแตงความคมชัดของภาพใหเหมาะสม สดใส ภาพทุกภาพควรอยูในแนวนอนใน

อัตราสวน 4:3 หากภาพเปนแนวตั้งอาจจะตองใชโปรแกรมตกแตงภาพ เชน PhotoShop ชวยใน

การสรางภาพใหมใหเหมาะสมกับการใชงาน 

3. รวมภาพทั้งหมดไวในโฟลเดอรชื่อ Images หรือช่ืออ่ืนๆ ตามตองการ 

หมายเหตุ เนื่องจากโปรแกรม ProShow Gold ไมสนับการตั้งชื่อไฟลและโฟลเดอรเปน

ภาษาไทย ดังนั้นจึงควรหลีกเลี่ยงการตั้งชื่อไฟลภาษาไทย หากนํามาจากที่อ่ืนๆ ให

เปลี่ยนชื่อใหมเปนภาษาอังกฤษ เพื่อความสะดวกในการใชงานแทรกภาพและเสียง 

 

การใชงาน ProShow Gold 
เมื่อเปดโปรแกรม ProShow Gold ข้ึนมาจะพบกับหนาตางโปรแกรมดังภาพดานลางนี้ 

เมนูโปรแกรม โฟลเดอรงาน ไอคอนทางลัด พื้นที่แสดงตัวอยาง 

 
 

เฟรมภาพ แถบเสียง ปุมควบคุมการแสดงตัวอยาง เวลาโดยรวม เวลาของเฟรมนี้ 
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การสรางงานนําเสนอจากโปรแกรม ProShow Gold นั้นเมื่อเราเตรียมงานเขียนบทลําดับ

เร่ือง การเตรียมภาพประกอบ การบันทึกเสียงบรรยายและเสียงประกอบ ไวเรียบรอยแลว ข้ันตอน

สําคัญคือการจัดเรียงลําดับภาพใหสอดคลองกับเสียงบรรยาย 
 

 
 

ข้ันตอนการสรางงานของเราจากภาพดานบน ในวงกลมสีแดงคือโฟลเดอรเก็บภาพและ

เสียงในการสรางงานของเรา การนําเสนอในตัวอยางนี้เปนการทํา Music Video เพลงประกอบ

ภาพ คร้ังแรกในการไปผจญภัยในตางแดนคนละซีกโลกของครูมนตรี จึงใหชื่อวา My First Time 

โดยเลือกใชเพลงสากลชื่อ My First Time เปนเสียงประกอบไมมีคําบรรยาย ข้ันตอนการทํางานมี

ดังนี้ 

1. คลิกที่ไฟลเพลง My First Time ในโฟลเดอร Sound แลวลากมาวางในแถบ Sound 

track (โปรแกรมรองรับไฟลในหลายฟอรแมตแตในการใชงานจริงจะเปนไฟลนามสกุล .wav 

โปรแกรมจะทําการแปลงเพื่อนําเขาเองโดยอัตโนมัติ เหตุนี้เองในขั้นตอนการ Export เสียงจาก

โปรแกรม Nero SoundTrax จึงแนะนําใหสงออกเปนไฟล Wave) รอสักครูจนกวาการนําเขาจะ

สําเร็จ ปรากฏวา เพลงนี้มีความยาวทั้งสิ้น 3 นาที 15.44 วินาที 

2. ข้ันตอนที่สองเราจะเปลี่ยนโฟลเดอรไปที่ Images เพื่อเลือกภาพมาวางในชอง Slide 

โดยเริ่มที่การคลิกเมาสขวาที่ไสลดชองแรกเลือก Insert Blank Slide กอนแลวตอที่ภาพถายจาก
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เครื่องบินผานหนาตางมองเห็นปกเครื่องบินและทิวทัศนเบื้องลาง จากนั้นนําภาพที่ไปตอยัง

สถานที่ตางๆ ในออสเตรเลียมาวางลงตามลําดับ 

 
เทคนิคการเปลี่ยนภาพ เวลาในการเปลี่ยนภาพ เวลาในการแสดงภาพ ปุมแสดงตัวอยางงาน 

จากภาพบนจะเห็นวาเมื่อมีการนําภาพมาเรียงลงในแตละไสลด จะมีสัญลักษณ  

มาคั่นระหวางภาพแสดงเทคนิคการเลือนภาพเขาหากันจาก A -> B และมีคาตัวเลขบอก

ระยะเวลาที่ทําการเปลี่ยนภาพมีหนวยเปนวินาที และในไสลดแตละชองจะมีหมายเลขบอกลําดับ

ไสลดดานซายมือและมีตัวเลขบอกเวลาการแสดงภาพดานขวามือมีหนวยเปนวินาที 

3. เราสามารถแสดงตัวอยางของงานไดดวยการคลิกที่ไสลดภาพแรก และคลิกที่ปุมเลน

ในกรอบชุดควบคุมการแสดงภาพตัวอยาง 

 
4. การปรับแตงการเปลี่ยนภาพ ถาเราตองการใหโปรแกรมใสเทคนิคการเปลี่ยนภาพให

เราเองอัตโนมัติแบบสุมก็สามารถทําไดดวยการคลิกที่สไลดภาพใดๆ แลวกดปุม Ctrl+A หรือไปที่
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เมนู Edit > Select All เพื่อเลือกสไลดทั้งหมด แลวไปที่เมนู Slide > Randomize Transition จะ

เห็นวาปุม AB ระหวางสไลดเปลี่ยนไปหลายรูปแบบ 

5. หากตองการกําหนดการสรางเทคนิคการเปลี่ยนภาพเองก็สามารถทําได โดยเมื่อนํา
เมาสไปคลิกที่ปุม AB จะมีกรอบแสดงเทคนิคการเปลี่ยนภาพมาใหเลือกจํานวนมากดังภาพ 

 
เมื่อนําเมาสไปวางเหนือรูปแบบใด จะมีภาพตัวอยางแสดงผลใหดูที่มุมซายลาง ดานขวา

ลางสุดจะเปนรูปแบบที่เลือกใชบอยๆ ในการสรางงานครั้งกอน (ถายังไมเคยใชงานปุมจะมีจํานวน

นอยกวานี้) สวนแถวบนถัดไปเปนปุมเทคนิคมาตรฐานที่เลือกใชบอยสุด 

6. นอกจากเทคนิคพิเศษการเปลี่ยนภาพแลว ยังมีเทคนิคการเคลื่อนที่ของภาพในแตละ

สไลดเพื่อทําใหเกิดความรูสึกเสมือนหนึ่งมีการเคลื่อนไหวของกลอง เชน การขยับกลองจากซายไป

ขวา หรือขวาไปซาย (PAN) การดึงภาพเขามาใกลหรือถอยออกมาไกล (Zoom in and Zoom out) 

หรือการกม/เงยกลองจากบนลงลางหรือลางขึ้นบน (Tilt up or Tilt down) 

วิธีการงายๆ สําหรับมือใหมหัดสรางงานนําเสนอ คือการเลือกไสลดทั้งหมด (คลิกที่ไสลด

ใดๆ กดปุม Ctrl + A) แลวไปที่เมนู Slide > Random Motion Effect โปรแกรมจะทําการสุมใส

เทคนิคพิเศษใหกับสไลดแตละภาพอยางอัตโนมัติและมีความตอเนื่องสัมพันธกันใหทันที 

7. ในกรณีที่ไมตองการใหโปรแกรมใสเทคนิคพิเศษการเคลื่อนที่ของภาพให เราสามารถ
ทําการปรับแตงในแตละสไลดไดโดยตรงดวยการดับเบิ้ลคลิกที่สไลดที่ตองการกําหนดจะปรากฏวา 
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มีกรอบการกําหนด Motion and Effects ข้ึนดังภาพบน ในภาพซายคือจุดเริ่มตนแสดง

ไสลด ภาพขวาคือจุดสิ้นสุดการแสดงไสลด เราสามารถปรับเปลี่ยนตําแหนงภาพดวยการใชเมาส

คลิกที่ภาพเลื่อนไปตําแหนงที่ตองการไดโดยตรงทั้งสองภาพ หรือหากตองการความละเอียด

สามารถกําหนดคาตัวเลขในชองดานบนได (ในกรอบสวางภายในภาพคือบริเวณแสดงผลจริงของ

งานที่ปรากฏบนจอ) 

ในปุมดานซายมือยังเสริมเทคนิคพิเศษใหกับภาพไดดังนี้ 

 Image / Video หมายความวาสามารถนําเขาคลิปวีดิโอแทนภาพนิ่งได 

 Adjustments คือปุมที่ทําหนาที่ตกแตงภาพ แกไขภาพที่อาจจะมืดไปนิด สวางไป

หนอย ไมคอยสัมพันธกับภาพกอนหนาหรือภาพถัดไป ก็สามารถปรับเพิ่มเติมได 

 Motion Effects คือการกําหนดการเคลื่อนที่รูปแบบตางๆ ของภาพ 

 Captions คือการใสหัวเรื่องหรือคําอธิบายภาพนั้นๆ ลงไป รวมทั้งการกําหนดเทคนิค

พิเศษใหกับตัวอักษรนั้นๆ ทั้งดานรูปแบบตัวอักษร ขนาดและสีสัน รวมทั้งการ

เคลื่อนไหวของตัวอักษรในรูปแบบตางๆ  

 Sound คือการแทรกเสียงเฉพาะที่เกี่ยวกับภาพนี้ลงไปเปนกรณีพิเศษ ไมเกี่ยวกับ

เสียงบรรยายที่เปนแบ็คกราวด ดวยการนําเสียงมาจากไฟล หรือบันทึกเสียงจาก

ไมโครโฟนลงไปโดยตรง 
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 Background คือสีพื้นหลังในกรณีที่เปนภาพแนวตั้งจะมีเนื้อที่ขอบดานขางซายขวา 

สามารถกําหนดสีใหแสดงหลังภาพได คาปกติคือสีดําเปลี่ยนแปลงไดตามตองการ 

หรือจะใชไฟลภาพใดภาพหนึ่งเปนพื้นหลังก็ได 

 
ในการพิมพตัวอักษร เนื่องจากตัวโปรแกรมยังไมสนับสนุนภาษาไทยโดยตรง แตก็

สามารถแทรกลงไปไดดังภาพบน ในชอง Captions และ Text จะอานไมออก แตในภาพจะอานได

ตามปกติ 

เทคนิคในการทําใหการแสดงผลภาษาไทยดูดี ในการพิมพถามีสระบนหรือลางใหเคาะเวน

วรรคหนึ่งเคาะกอน คอยพิมพตัวอักษรถัดไปจะแสดงผลไดสวยงาม เมื่อกําหนดทุกอยางไดตาม

ตองการแลวคลิกที่ปุม Done มุมขวาลางเพื่อกลับไปที่งานดังเดิม 

8. หลังจากการกําหนดเทคนิคพิเศษตางๆ จนเปนที่พอใจแลว ก็ลองแสดงตัวอยางดู จาก

เฟรมแรกไปจนเฟรมสุดทาย คอยสังเกตที่ตําแหนงสไลดตางๆ ขณะแสดงผล ถาจุดใดบกพรองให

บันทึกไวเพื่อทําการแกไขในภายหลัง 

9. ทําการแกไขจุดบกพรองตางๆ ตามที่บันทึกไว จนเปนที่พอใจใหบันทึกจัดเก็บไฟลดวย

การคลิกที่เมนู File > Save หรือ กดปุม Ctrl + S หรือคลิกที่รูปแผนดิสเก็ตตก็ได ตั้งชื่อไฟลตาม

ตองการจากตัวอยางนี้ บันทึกในชื่อ MyFirstTime.psh ซึ่งสามารถแกไขเพิ่มเติม ปรับเปลี่ยนไดใน

ภายหลัง 
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การบันทึกช้ินงานลงใน VideoCD/DVD 
โปรแกรม ProShow Gold สามารถบันทึกงานที่ทําสําเร็จแลวลงในแผน CD/DVD เพื่อ

นําไปเปดในเครื่องเลนซีดี/ดีวีดี ทั่วไปได หรือจะเปดในเครื่องคอมพิวเตอรที่ไมมีโปรแกรม 

ProShow Gold ติดตั้งอยูเลยก็ไดแบบ AutoRun 

ตัวอยางนี้จะเปนการสรางแผนวีซีดีธรรมดา (เพราะไมมีไดรวเขียนดีวีดี) ใหคลิกที่เมนู 

Create > Video CD หรือกดปุม Alt + V หรือคลิกที่ปุมไอคอน VideoCD ก็ไดจะพบกับหนาจอรูป

ขางบนนี้ จะพบกับหัวขอตางๆ ดังนี้ 

• Menus คือการสรางเมนูสําหรับแสดงกอนเริ่มเลน (ไมมีความจําเปนนัก เพราะ

เรามีอยูเร่ืองเดียว ตอนเดียว 

   
• Shows คือการกําหนดไตเติ้ลผูผลิตหรือขอความแสดงลิขสิทธิ์ตางๆ ถาไมมีจะเอา

ไตเติ้ลที่ ProShow สรางไวใหก็ได 
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การสรางงานนําเสนอดวย ProShow Gold 24 

• Output Options สําหรับการกําหนดรูปแบบของไฟลงานวาตองการอยางไร เชน

การแสดงภาพนิ่ง วีดิโอ ถาเปนวีดิโอจะตองกําหนดดวยวาเปนระบบใด NTSC 

หรือ PAL (ประเทศไทยใชระบบ PAL) การกําหนดไดรวเขียนซีดี (ถามีไดรวเขียน

ซีดีโปรแกรมจะเลือกเองอัตโนมัติ ถาไมมีโปรแกรมจะเลือกเขียนเปน Image File 

เพื่อนําไปเขียนในเครื่องอื่นได) รวมทั้งจะใหโปรแกรมนําภาพนิ่งตนฉบับไปสราง

โฟลเดอรไวในซีดีหรือไม (ถามีพื้นที่เหลือ) 

• PC Autorun คือการกําหนดใหโปรแกรมสรางไฟลเลนซีดีอัตโนมัติในคอมพิวเตอร 

ตองการแสดงโชวแบบวนไมรูจบหรือไม ขนาดของการแสดงผลบนจอเริ่มตนที่

ขนาดใด และสูงสุดที่ขนาดใดเพื่อใหชิ้นงานยังคงคุณภาพ นอกจากนั้นโปรแกรม

ยังมีการเขารหัสปองกันการชมตามระยะเวลาที่กําหนดไดดวย 

 
เมื่อกําหนดคาตางๆ ครบถวนถูกตองแลวก็คลิกที่ปุม Create ไดเลย โปรแกรมจะทําการ

สรางไฟลวีดิโออาจจะใชเวลามากนอยแลวแตทรัพยากรเครื่องของทานวาเร็วเพียงไร เมื่อเสร็จส้ิน

โปรแกรมจะใหใสแผนซีดี หรือถาไมมีไดรวเขียนโปรแกรมจะถามวาจะเก็บไฟลงานไวที่ใดเพือ่นาํไป

เขียนตอในเครื่องอื่นๆ 
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การสรางงานนําเสนอดวย ProShow Gold 25 

นอกจากนี้แลวโปรแกรม ProShow Gold ยังสามารถสรางงานอื่นๆ ไดอีกมาก เชน การ

สรางสื่อนําเสนอบนเว็บไซต การแชรไฟลใหกับบุคคลอ่ืนๆ การสรางไฟลสําหรับแสดงดวยตนเอง 

(Executable) การสรางภาพแสดงหนาจอคอมพิวเตอรในชวงพักการทํางาน (Scree Saver) 

 

ซึ่งความสามารถเหลานี้ ทานคงจะสามารถศึกษาเพิ่มเติมดวยตนเองได จากการชวยเหลอื

ของโปรแกรมเมื่อคลิกที่ปุม Help แนนอนทานตองใชความสามารถพิเศษในการทําความเขาใจ

จากภาษาอังกฤษเพิ่มเติม 

การหมั่นฝกฝนและกลาที่จะทดลองทําจะชวยใหทานประสบผลสําเร็จ หวังวาคูมือเลมนี้

และไฟลตัวอยางในแผนซีดี จะชวยใหทานสรางงานไดประสบผลสําเร็จ.... 

พยายามตอไปครับ ขอเปนกําลังใจใหคุณ....ดวยใจจริง 

 

มนตรี  โคตรคันทา 
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